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Extron Certified DSP Bundle for Microsoft® Teams® 
Rooms – Large Room • Setup Guide

IMPORTANT NOTE:              	  
Go to www.extron.com for the complete user guide, installation instructions, and specifications.

Microsoft Teams and Extron have come together to provide Teams Rooms solutions with our certified hardware. Now it is easier 
than ever to stay connected with flexibility of real-time collaboration from anywhere. The products in our Teams Rooms Certified 
Design Solutions have been designed and meticulously tested for best-in-class performance and ease of use.

Requirements
Extron Equipment List

Product Description Quantity
DTP3 CrossPoint 884 IPCP A Audio and Video Matrix with 200 watt Amplifier 1
SF 26CT LP 6.5" Low profile, 2-way Ceiling Speakers, pair 2
DTP3 T 202 4K/60 HDMI DTP3 Transmitter with Input Loop-Through 2
DTP3 R 201 4K/60 HDMI DTP3 Receiver with Audio De-Embedding 2
HDMI Ultra/9 Ultra Flexible Premium High Speed Cables - 9' (2.7 m) 4
MBU 125 1/4 and 1/2 Rack Width Low-Profile Mount Kit 4
XTP DTP 22/35 Precision-terminated Shielded Twisted Pair Cables - 35' (10.6 m) 4
SPK 16P/1000 16 AWG Plenum Speaker Cable - 75' (22.8 m) 1
USBC Config cable USB-C to USB-C 5 Gbps Cable - 6' (1.8 m) 1
Network cable Cat-6 Plenum network cable - 35' (10.7 m) 2
Network cable Cat-6 Plenum network cable - 50' (15.2 m) 2
Network cable Cat-6 cable non Plenum - 6' (1.8 m) 2

Audio Technica® Equipment List
Product Description Quantity
ATND1061DAN Beamforming Ceiling Array Microphone 1
ESW-T4102/C510 Handheld Transmitter 1
ESW-T4101 Body-Pack Transmitter 1
ESW-R4180DAN 8-Channel Wireless Receiver 1
ESW-CHG4AD Two-Bay Body Pack and Handheld Charging Station with Power Supply 1

Additional Required Equipment
Product Description Quantity
Teams Rooms computer Teams Rooms computer with camera and control interface 1
Network switch 10-port PoE network switch 1
Windows® computer or laptop Computer MUST contain the following:

•	 Extron DSP Configurator Pro
•	 Extron Global Configurator Plus and Professional
•	 Extron Toolbelt
•	 Dante Controller
•	 Audio Technica Digital Microphone Manager
•	 Audio Technica Wireless Manager
•	 Extron system configuration *.zip files
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NOTE:	 The Windows computer or laptop is required for adjustments and can be disconnected after system configuration.

https://www.extron.com
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Figure 1.	 System Diagram Example

NOTE:	 The supplied network switch is manageable. However, the default configuration is sufficient for this solution to function.

Installation Details

Amplifier and Speaker Installation
During installation of the amplifier and speakers, ensure that their settings are compatible. The provided DTP3 CrossPoint 
configuration sets the Amplifier Output Mode to Bridged Mono, 70 V (see figure 3 for wiring). For compatibility, set each SF 26CT LP 
rotary tap selector switch to 70 V, 16 W (see figure 2).
For detailed setup instructions, see the included DTP3 CrossPoint 884 Setup Guide and SF 26CT LP Setup Guide.
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Figure 2.	 Adjusting the Speaker
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Configuration Overview
1.	 Unbox and connect the provided hardware using the diagram in figure 1 on page 2.

NOTE:	 Do not connect the USB cable between the Microsoft Teams Rooms computer and Extron 
DTP3 CrossPoint 884 IPCP A until after the Extron DTP3 CrossPoint 884 IPCP A is completely configured.

2.	 Install the following software utilities on the computer:
•	 Extron DSP Configurator Pro
•	 Extron Global Configurator Plus and Professional
•	 Extron Toolbelt

•	 Dante Controller Software
•	 Audio Technica Digital Microphone Manager (DMM)
•	 Audio Technica Wireless Manager

3.	 Download the following from the Extron website (www.extron.com):
•	 Extron Large Conference Room System File .zip folder

Audio Technica ATND1061 Microphone Setup
A single network cable connection from the Audio Technica ATND1061 to the network switch supports PoE into the microphone, 
Dante audio, and LED feedback for call and mute status. The Audio Technica Digital Microphone Manager software detects and 
identifies the ATND1061 when the network cable is attached to the Network A port and the microphone is powered on.
From this interface, carry out the following actions in the order they are listed.

Connecting Microphones
1.	 Set the computer to automatically obtain IP address settings.
2.	 Connect to the same network the microphones and the computer with Digital Microphone Manager installed. 

The microphones ship from the factory with IP Config Mode set to Auto. 
3.	 Launch Digital Microphone Manager (see figure 4).
4.	 Select the Open Project button from the main menu.
5.	 Open a browser and navigate to the DMM project file and select Open or double click on the file.

The Digital Microphone Manager window opens to connect the microphones (see figure 5).

Figure 4.	 Digital Microphone 
Manager Main Menu

Figure 5.	 Digital Microphone Manager Window with Open File

4  
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6.	 Click the arrow beside Disconnected for the desired microphone and select Connect (see figure 6).
The Connect to Device screen opens (see figure 7).

Figure 6.	 Connect Device List

7.	 Select the App → Device radio button.
8.	 Select the desired microphone radio button in the 

Device panel.
9.	 Click OK. 

A Preset status box opens (see figure 8, top).
10.	 Wait for the Preset status to change from 

Saving... to Complete (see figure 8, bottom). Figure 7.	 Connect to Device Window

11.	 Click OK when complete.
The Digital Microphone Manager window opens, displaying the selected microphone is Connected (see figure 9).
Repeat steps 6 through 10 to connect the second microphone.

Figure 8.	 Connection 
Status Box

Figure 9.	 Digital Microphone Manager Window with Connected Microphone
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Room Settings and Beam Configuration
The provided DMM project file utilizes priority zones on the ATND1061 microphone, which are configured to cover a single room. 
Use the Digital Microphone Manager software to verify the signal strength by reviewing the meters while speaking from each 
priority zone around the microphones. If necessary, the Room Settings and Priority Zones can be modified to better suit the 
room configuration. 

NOTE:	 See the Digital Microphone Manager instruction manual for more information.

Audio Settings
The audio settings are pre-configured in the previously download project file (see Configuration Overview on page 3). Before 
moving forward, confirm that AEC is enabled (see figure 10, 1), to ensure an AEC reference can be received over Dante.

Figure 10.	 Audio Board Controls with AEC Enabled

System Settings

General panel
To configure the system:
1.	 Select a microphone from the device list. The 

microphone settings screen displays in the right panel. 
2.	 Click the gear icon in the right panel (see figure 10, 

2). The Settings & Maintenance screen opens (see 
figure 11).

3.	 Open the settings menu and click on a setting.
•	 For text settings, click the field and enter the text.
•	 For drop-down settings, click the arrow for the 

setting and make a selection from the list.
•	 For switch settings, click the switch. Switches turn 

blue (ON) and no color (OFF).
4.	 Click Apply to save the settings.

Click Cancel to return to previous settings.
5.	 Click OK to exit.
To change a device name:
Click in the Device Name field and enter the name.

Figure 11.	 Settings & Maintenance General Panel

10  
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Network panel
Configure the Dante and IP control network settings as 
needed.

Figure 12.	 Settings & Maintenance Audio Panel

Audio panel
Audio settings are pre-configured in the previously 
downloaded project file (see Configuration Overview on 
page 3).
Confirm the following settings:
Beam Settings —
•	 Beam Sensitivity — Low
•	 Auto Attenuation — Disabled
•	 Room Type — Live

DSP Mode — AEC Mode

Figure 13.	 Settings & Maintenance Audio Panel

Audio Technica Engineered Sound Wireless System
NOTE:	 For more detailed information on the Audio Technica Wireless Manager software, see the Audio Technica 

documentation included with the microphones and receiver.

The provided wireless microphone system includes the ESW-R4180DAN, which receives audio signals from the ESW-T4101 and 
ESW-4102 transmitters. The Audio Technica Wireless Manager software is used to discover and configure the connected wireless 
devices.
To set up the Audio Technica Engineered Wireless System:
1.	 Connect the ESW-R4180 receiver to the network switch RJ-45 port.

NOTE:	 The ESW-R4180 receiver is PoE powered.

2.	 Connect the ESW-CHG4 charging station to the network switch RJ-45 port.
3.	 Connect power to the ESW-CHG4.
4.	 Insert the ESW-T4101 and ESW-4102 microphones into the ESW-CHG4 charging station.
5.	 Connect the PC to the same network as the receiver and charging station and set the IP settings to DHCP.
6.	 Start the Wireless Manager software.
7.	 Open the provided configuration file — WMPROJ file (see figure 14 on page 7).

12  

13  
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Figure 14.	 Wireless Manager Screen with the Open WMPROJ File

8.	 Click the Unsynced Devices button (see figure 14, 1). The Unsynced Devices window opens (see figure 15).

Figure 15.	 Wireless Manager Unsynced Devices Window

a.	 Click and drag each discovered device in the Unsynced Devices window to the corresponding model in the Device List. 
The Retain Device Settings Of dialog box opens (see figure 16 on page 8).

14  
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Figure 16.	 Retain Device Settings Of Dialog Box

b.	 In the Retain Device Settings Of dialog box, select the Software (excl. network setting) radio button.
c.	 Click OK to save the selection or Cancel to exit without making changes.

9.	 Pair the transmitter and receiver:
a.	 Remove the microphone from the charging station.
b.	 Press and hold the power button on the transmitter for approximately 2 seconds and then release the button.
c.	 The transmitter turns on and automatically searches for the link destination. When the link is established, the link indicator 

lamp on the receiver and the status indicator lamp on the transmitter light.
10.	 Use the software to validate the microphone audio is passing.
11.	 Click the gear icon (see figure 14, 2 on page 7) for the receiver to set the network settings and note the IP addresses. 

The DeviceSetting window opens.

Figure 17.	 DeviceSetting Window

a.	 Select the Network tab.
b.	 Click in the fields for the IP Settings and set as needed.
c.	 Click Apply to save the IP settings.
d.	 Repeat these steps for each microphone 

16  
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Dante Controller Setup
Dante Controller from Audinate® is required to route transmitters and receivers, and can be used to configure Dante settings and 
monitor performance.

General steps
•	 Connect the computer and devices to the network switch
•	 Open Dante Controller
•	 Discover devices
•	 Update network settings as needed

•	 Name devices
•	 Name transmitter and receiver channels
•	 Create subscriptions

Create the following subscriptions in Dante Controller to route audio signals between the audio devices in the system (default 
channel names are noted):

ATND1061DAN and DTP3 CrossPoint 884 Subscriptions
Dante Transmit Dante Receive
Device Channel Device Channel

ATND1061DAN Ch 2 DTP3 CrossPoint 884 AT#01
ATND1061DAN Ch 3 DTP3 CrossPoint 884 AT#02
ATND1061DAN Ch 4 DTP3 CrossPoint 884 AT#03
DTP3 CrossPoint 884 AT Out#01 ATND1061DAN AEC Ref In

ESW-R4180DAN and DTP3 CrossPoint 884 Subscriptions
Dante Transmit Dante Receive
Device Channel Device Channel

ESW-R4180DAN RX1 Output DTP3 CrossPoint 884 AT#04

ESW-R4180DAN RX2 Output DTP3 CrossPoint 884 AT#05

Creating Subscriptions Between the Audio Technica Microphones and Extron 
DTP3 CrossPoint IPCP A

ATTENTION:	
•	 It is essential that a Dante device be named before audio subscriptions with other devices are established. Existing 

subscriptions are removed when a device is renamed.
•	 Il est essentiel qu’un appareil Dante soit nommé avant l’établissement des abonnements audio avec d’autres appareils. 

Les abonnements existants sont supprimés lorsqu’un appareil est renommé.

NOTE:	 Optionally, see Renaming Transmitters and Receivers (Optional) on page 10 to change device names before 
making subscriptions.
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1.	 Ensure the laptop, DTP3 CrossPoint 884 IPCP A (Dante), and Audio Technica 
devices (Dante) are connected to the same network.

2.	 From the Windows Start menu select: All Programs > Audinate > Dante 
Controller. The Dante Controller - Network View screen opens.
The Dante Controller auto-discovers Dante devices on the network and 
advertises itself to allow other Dante-enabled devices to communicate with it. 
Transmitters connect to receivers using the subscription matrix.

NOTE:	 The DTP3 CrossPoint 884 IPCP A and Audio Technica Dante 
device connections are set to DHCP by default. If they cannot be 
discovered, ensure the correct interface is selected on the PC by 
selecting Interfaces from the File list.

3.	 To show the transmitters of a Dante device, click the + box next to the desired 
device in the Dante Transmitters panel, such as DTP3-CP-2c50d4. The + 
changes to a – sign when the device expands.

4.	 To show the receivers of a Dante device, click the + box next to the desired 
device in the Dante Receivers panel, such as DTP3-CP-2c50d4.

5.	 Click the intersection between a transmitter and a receiver. Figure 18.	 Subscriptions
A check mark at the intersection indicates the subscription is made. A check mark also appears next to the receiver channel.

NOTE:	 A receiver can connect to only one transmitter. A transmitter can connect to multiple receivers.

Renaming Transmitters and Receivers (Optional)

To rename transmitters and receivers:
1.	 From the Device View drop-down list, choose the Dante device.
2.	 Select the Receive tab.
3.	 Click a receive channel name and rename it.
4.	 Select the Transmit tab.
5.	 Click a transmit channel name and rename it.
6.	 Select the Device Config tab and rename the Dante device as desired.
7.	 Click Apply.
8.	 Repeat steps 1 through 7 for each Dante device.
See figure 19 and figure 20 to view an example of the Receive and Transmit lists of devices.

Figure 19.	 DTP3 CrossPoint 884 Receiver Name

Figure 20.	 ATND1061DAN Transmitter Name

18  

19  

20  
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Extron DTP3 CrossPoint 884 IPCP A Setup
To configure the Extron DTP3 CrossPoint 884 IPCP A:
1.	 Connect to the AV LAN port of the DTP3 CrossPoint 884 IPCP A.
2.	 Set the PC IP address within the range of the product IP address. If they have not been changed, the default settings to 

connect through the IPCP Pro 360MQ xi card AV LAN ports are:
•	 IP address: 192.168.254.254
•	 Subnet: 255.255.255.0
•	 Gateway: 0.0.0.0

3.	 From a web browser, enter the device IP address into the address field.
4.	 Press Enter.
5.	 On the login page, enter admin as the Username, enter the 

Password, and click Sign In.
•	 By default, the password is the product serial number.
•	 If a Full Factory Reset has been performed, then the 

password converts to the default, extron.
6.	 The Network panel displays connection settings. Click Edit 

to edit the TCP/IP settings.
The following can be edited: device name, DHCP status, 
IP address, subnet mask, default gateway, and DNS server. 
The device MAC address is also displayed. 

NOTE:	 If DHCP is enabled, IP address, subnet mask, 
and default gateway cannot be edited.

Figure 21.	 Login Page

Figure 22.	 DTP3 CrossPoint Internal Web Page

21  
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To push the DSP Template file to the DTP3 CrossPoint 884 IPCP A:

NOTE:	 An Extron Insider account is required to download and use DSP Configurator Pro.

1.	 Open the Extron DSP Configurator Pro.
2.	 Select the Open File tab and click BROWSE FILES (see figure 23). The 

Open Configuration File... box opens.
3.	 Navigate to the location on the PC that the Extron .edc file was saved 

(downloaded previously in .zip file) and double click to open.
The open file is displayed in DSP Configurator Pro.

4.	 Click the Push button (see figure 24, 1). 
The Push Configuration box opens (see figure 25). Figure 23.	 Connect TCP/IP Panel

Figure 24.	 Push Button on the DSP Toolbar

5.	 In the Push Configuration panel, enter the IP address of the 
device in the Hostname or IP Address field. 

NOTE:	 If the IP address was not changed, the default 
it 192.168.254.254.

6.	 Leave the Telnet Port field empty.
7.	 Enter the device password in the Password field.

NOTE:	 If the password was not changed, the default 
is the device serial number.

8.	 Click Push (the button is blue when the device connection 
fields are filled in).

9.	 Open DSP Configuration by double clicking DTP3 CrossPoint 
in the Device Manager panel.

Figure 25.	 Pushed Configuration Box 

23  
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Naming USB Audio Interface
The USB Audio tab allows for customizing USB audio interface 
names and terminal types.

NOTE:	 Extron recommends configuring these settings 
before connecting USB audio devices to a PC.

To configure USB Audio name in DSP Configurator Pro:
1.	 From the Tools menu, select Device Settings. 

The Device Settings box opens (see figure 26).
2.	 Click the USB Audio tab.
3.	 In the USB Name field, enter the desired name for the USB 

Audio interface.
4.	 In the USB 1 Terminal Type field, select the Echo 

Cancelling Speakerphone radio button.
5.	 Click Apply to activate the new settings.
6.	 Connect the PC to the USB Audio port.

Figure 26.	 USB Audio Tab

Setting Amplifier Output Mode
The Amplifier Settings box allows the user to select the 
amplifier output mode.
To configure USB Audio settings in DSP Configurator Pro:
1.	 Right click the open device and select Amplifier Setting 

(see figure 27).
The Amplifier Settings box opens (see figure 28).

2.	 Select the Bridged Mono, 70 volts radio button.
3.	 Click Apply to activate the new settings.
4.	 Connect the PC to the USB Audio port. Figure 27.	 Amplifier 

Settings
Figure 28.	 Amplifier Output 

Mode

USB Audio Settings Confirmation
The USB Audio settings are configured in the .edc file, but should 
be confirmed after pushing the file to the DTP3 CrossPoint.
To confirm Amplifier settings in DSP Configurator Pro:
1.	 From the Tools menu, select USB Audio.

The USB Audio box opens (see figure 29).
2.	 Confirm the USB Channel Configuration drop-down lists 

display 2 Inputs and 2 Outputs.
USB Audio Controls:
•	 USB 1 Input Gain and Mute groups are assigned to 

groups affecting far end speaker audio.
•	 USB 1 Output Gain and Mute groups are assigned to 

groups affecting near end microphone audio.

Figure 29.	 USB Audio Box

26  
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Extron IPCP Pro 360MQ xi Setup
The Control Processor in this system facilitates the communication between the Extron DTP3 CrossPoint 884 IPCP A and Audio 
Technica microphone.

Get Ready
1.	 Download and install the latest version of the following software:

•	 Toolbelt — For discovering the control processor and other control products on the network, for managing core settings, 
and for upgrading firmware when needed.

•	 Global Configurator Plus and Professional (GCP) — For configuring the control system.
2.	 Obtain network information for the unit from the network administrator. You also need the following details for each Extron Pro 

series Ethernet-enabled device:
•	 DHCP setting (on or off) •	 Subnet mask •	 Username
•	 LAN IP address •	 Gateway IP address •	 Passwords
•	 AV LAN IP address

NOTE:	 If DHCP is on, you do not need the IP addresses and subnet mask.

3.	 Write down the MAC address of each network interface on each IP Link Pro device to be used.
4.	 Obtain model names and setup information for devices the IPCP controls.

Mount and Cable All Devices
1.	 Cable devices to the control processor.
2.	 Connect power cords and power on all the devices.

Network Communication Setup	
Network setup is essential prior to configuration. Use the flowchart at 
right as a guide to setting up the control processor for network use.

NOTE:	 If using 802.1X security, see the Extron 802.1X 
Technology Reference Guide and the Toolbelt Help file for 
additional details on system setup.

Open the Toolbelt software from within 
Global Con�gurator (GC Professional or 

GC Plus mode) or as the stand-alone 
application. 

Start Device Discovery.
Toolbelt displays a list of all Extron control 

devices connected to the network.

Using the MAC address, locate the desired 
control processor in the list and select it.

Network Communication Setup

Connect the PC and the LAN port or AV LAN 
port of the control processor to 

the same network.
Apply power to all devices.

For each network interface 
(LAN, or LAN and AV LAN), use the Set IP 

feature in Toolbelt or use the 
Toolbelt Manage > Network Settings tab 

feature to enter the IP address and 
subnet address, then con�gure other 

network settings as needed.
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Set Up the Control Processor for Network Communication.
1.	 Connect the PC to be used for setup and the AV LAN port of the control 

processor to the same Ethernet network.
2.	 Start Toolbelt and use it to discover the IPCP Pro 360MQ xi card (see 

figure 30):
3.	 Log on to the unit (see figure 31).

NOTES:
•	 The factory configured passwords for all accounts on this device 

have been set to the device serial number. Passwords can be 
changed during configuration. Passwords are case sensitive.

•	 If the device is reset to default settings, the default password for all 
accounts is extron.

4.	 If required, change the password (see figure 32).
5.	 Set the DHCP status, IP address, subnet, gateway IP address, and related 

settings (see figure 33).

NOTES:
•	 When setting up DHCP during network configuration or if using 

a host name instead of an IP address, the user must enter a 
qualified host name (Username.HostName.Domain). For example: 
somename.extron.com.

•	 A dedicated AV LAN safeguards AV systems from outside intrusion 
or interference by separating device control and other network 
traffic from a corporate or campus network. To ensure that the 
control processor LAN and AV LAN connections (ports) are 
connected to separate networks, the LAN and AV LAN IP address 
schemes must be on different subnetworks.

See the Network Communication Setup flow chart on page 14.
6.	 If required, apply a LinkLicense.

Figure 30.	 Discover with Toolbelt

Figure 31.	 Log on to IPCP Pro 360MQ xi

Figure 32.	 Change Password

Figure 33.	 Configure Network Settings

30  
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Configure or Program the Control Processor

NOTE: See the Global Configurator Plus and Professional Help File as needed for step-by-step instructions and detailed 
information. The help file for GCP includes an introduction to the software and how to start a project and configuration.

Using Global Configurator, configure the control processor. The configuration tells the control processor:
•	 How its ports function •	 How its ports function
•	 How to control other products •	 When to do things
•	 Whom to notify, how, and under what circumstances

Configuration with GC Plus
1.	 Open the provided GC Plus configuration file. The software opens to Configuration view ( ). This option is also selectable 

from the View menu. 

Figure 34.	 Configuration View — System Settings page for Control Processor

2.	 Set the IP address (see figure 34, 1), IP address for AV LAN (2), and Admin password (3) of the Control Processor.

NOTE:	 The factory configured passwords for all accounts on a device are set to the device serial number. Passwords are 
case sensitive. If the device is reset to default settings, the password converts to the default password, extron.

3.	 Open the Communications Ports page (4).

Figure 35.	 Configuration View — Communications Ports page for DTP3 CrossPoint

4.	 Choose DTP3 CrossPoint under the Ethernet Ports list (see figure 35, 1).
5.	 Set IP address (2) and Admin password of the DTP3 CrossPoint device (3).

34  

35  
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Figure 36.	 Configuration View — Communications Ports page for Audio Technica
6.	 Choose the first Audio Technica under the Ethernet Ports list (see 

figure 36, 1).
7.	 Set the IP address (2) of the Audio Technica device.
8.	 Repeat steps 6 and 7 to configure the second Audio Technica device.
9.	 Open Build Manager view (see figure 37, 1, ). This option is also 

selectable from the View menu.
10.	 Under the Build & Upload section, click the Build button (2).
11.	 Wait for Verification. The Build and Upload bars show the progress.
12.	 Once the process is complete, the Build and Upload bars both show the 

message Complete (see figure 38).

Figure 37.	 Build Options panel

Figure 38.	 Build and Upload Completed

Test and Troubleshoot
Test the system (see the IPCP Pro Q xi and xi Series User Guide for an outline of the system testing procedure). Make adjustments 
to wiring or configuration as needed.

36  
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Microsoft Teams Rooms Setup
The Extron DTP3 CrossPoint 884 IPCP A connects to the Microsoft Teams Rooms system from the USB Audio port. Once the 
previous steps outlined in this document have been completed, please connect the Microsoft Teams Rooms system to the 
DTP3 CrossPoint 884 IPCP A USB Audio connection via the provided USB-C cable.
The following steps detail the required settings on the Microsoft Teams Rooms device:
Select Settings (see figure 39, 1) in the Microsoft Teams Rooms interface.

Figure 39.	 Microsoft Teams Rooms Setup

Microsoft Teams Rooms Interface Screen
Select the Extron DTP3 CrossPoint 884 IPCP A (or configured USB Name in above steps) for each of the two parameters: 
Microphone (see figure 40, 1) and Speaker (2).

Figure 40.	 Microsoft Teams Rooms Interface

Microsoft Teams Rooms Settings Menu

NOTE:	 When using the Extron DTP3 CrossPoint 884 IPCP A, Microsoft Teams Rooms disables its internal acoustic echo 
cancellation (AEC) audio processing so that all audio processing is completed through the external DSP—the Extron 
DTP3 CrossPoint 884 IPCP A. This provides the best audio performance.

39  
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DTP3 CrossPoint 884 IPCP A Acoustic Echo Cancellation (AEC)

AEC Setup Overview
Proper gain structure involves the relationship between the signal at the selected reference and the signal at the mic input, within 
the context of proper levels for the reference and mic inputs independently. The mic input gain setting is naturally optimized for the 
voice level of the talker in that room. Therefore, the amount of signal from the far end that is picked up by the mic is dependent on 
how much that far end signal is being amplified in the near end room and the distance from the mic to the speakers.
The reference signal is the signal received from the far end, which arrives at the USB-assigned Aux Inputs of the 
DTP3 CrossPoint 884 IPCP A. This is sent to the sound reinforcement system within the near end room, as well as a designated 
output channel to set the reference level for the DTP3 CrossPoint 884 IPCP A AEC processor.

AEC Dialog
The AEC dialog in DTP3 CrossPoint 884 IPCP A contains meters 
and indicator LEDs that are essential for setting up gain structure 
and monitoring activity. Go to Processors and select Acoustic 
Echo Cancellation (AEC).

A	 AEC Activity Indicators
•	 Far – Lights when activity is detected from the remote site.
•	 Near – Lights when activity is detected from the local site.
•	 Update – Lights when the AEC is updating (converging or 

reconverging)

B	 Meters
•	 ERL – The ratio in dB between the signal at the reference 

and the signal at the AEC channel input. When ERL is a 
positive number, the signal level at the AEC channel input 
is lower than the signal at the selected reference.

NOTE:	 The ideal level range for this meter is 0 to 
+15 dB. This ensures the right amount of reference 
signal is being sent through the AEC processor.

•	 ERLE – The amount in dB of potential echo signal that 
the AEC algorithm, not including NLP processing, is 
cancelling.

•	 TER – The sum of ERL + ERLE, in dB.

Figure 41.	 AEC Controls

C	 Reference Selection List — The provided configuration includes a selected AEC reference. If necessary, a different AEC 
reference can be selected from the drop-down list.

D	 Noise Cancellation Controls — Noise cancellation can be switched on or off from the AEC dialog. The noise canceller will 
detect steady state noise, such as HVAC or other continuous system noise, and effectively remove it without causing audible 
artifacts.

E	 Advanced AEC Controls — Click the expand and collapse icon to expose the advanced AEC controls.
Advanced control functionality is as follows:
•	 Non-linear Processing (NLP) Controls: 

•	 Enable NLP – This box is selected by default. Non-linear processing is necessary for the complete removal of echo.
•	 NLP Presets – Click a button to load a set of values to the three NLP parameters. If not using one of these presets, 

enter values into the fields for the following three controls:
•	 Max NLP Reduction – The maximum possible reduction in echo artifacts that can be applied
•	 Attack Time – The speed in which NLP is applied
•	 Release Time – The speed in which NLP is released

•	 Additional Controls:
•	 Double Talk Echo Reduction – Sets the amount of echo reduction applied during double-talk (when two people 

speak at the same time).
•	 Comfort Noise – Sets a comfort noise level in dB to eliminate states of complete silence, which may be perceived as 

a failed connection.
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For information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the Extron 
Safety and Regulatory Compliance Guide on the Extron website.
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